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On November 4, 1999 the National Federation of the Blind filed a federal lawsuit against
America Online. The lawsuit charges that AOL’s Internet service is incompatible with
software programs used by the blind to convert text to audio or Braille. While AOL has
said that the next version of their software will be more accessible to the blind, the
Federation argues that technology already exists to make their Internet service accessible,
and has asked AOL to redesign their site.

You may be asking what sort of technology are they talking about? In fact, there is a
wide range of software and hardware in use by the blind and disabled to make computers
more accessible. Alternatives to keyboards and mice are available for the physically
disabled. Software that magnifies portions of the screen can be used by the visually
impaired. The screen readers mentioned above can be used for reading Web pages, email,
word processing documents, etc. These are just a few of the hardware and software
solutions available to the disabled.

Unfortunately, over the last few years, much of the increased accessibility these tools
have offered has been eroded by the popularity of graphical user interfaces. Particularly
on the Web, a great deal of informational content is now being conveyed by graphics,
video, and audio instead of text. This, in addition to other design decisions, can shut out
the blind and disabled from many Web sites.

Several organizations have mobilized to raise awareness of the issue of Web page
accessibility. In particular the World Wide Web Consortium (W3C) created the Web
Accessibility Initiative in April 1997. In October 1997 the International Program Office
for the Web Accessibility Initiative was launched. The WAI International Program Office
was endorsed by the White House, and funded by the National Science Foundation, the
Department of Education’s National Institute on Disability and Rehabilitation Research,
the European Commission’s TIDE Programme, and W3C industry members. It
coordinates five activities with regard to Web accessibility:

▼ data formats and protocols
▼ guidelines for browsers, authoring tools, and content creation
▼ rating and certification
▼ education and outreach
▼ research and advanced development

Several working groups have been formed to work on guidelines for browsers, authoring
tools and content creation. The WAI Web Content Accessibility Guidelines were
published on May 5, 1999. The WAI User Agent Accessibility Guidelines and WAI
Authoring Tool Accessibility Guidelines are in the working draft stage.

(continued on page 3)
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Introducing…
WizCIS recently added the
Course Web Wizard to the
applications and services
available to the faculty and
students at HMC. The Course
Web Wizard (CWW) was
developed by the University
of Missouri at St. Louis to
help faculty create course
Web sites. It is designed to
allow a professor to quickly set up a course
Web site without any previous knowledge
of HTML. It automates the development of
the site by walking the professor through
the creation process, step by step. CWW is
written entirely in PERL script and is
completely Web-based.

The Course Web Wizard allows the
professor to create six different sections for
the course Web site:

▼ Syllabus
▼ Announcements
▼ Assignments
▼ Discussions
▼ Links
▼ Library

For the Syllabus section the professor can
either use the template provided or import
an already existing syllabus file. The
Announcements section can be used to
display timely information relative to the
course. Assignments are posted to the
Assignments section. The Discussions
section allows for interaction between
students and with the professor. The Links
section is where faculty can add links to
Web pages related to the course. Finally,
the Library link points to the Libraries of
the Claremont Colleges Web site, http://
voxlibris.claremont.edu.
Professors each have an account for their
course Web sites which allows them to
create and edit the Web pages. In addition,
there is a course login name and password
that students use to access the Discussion
page for each course.

The Course Web Wizard is in use at several
other colleges and universities including
Oakland University, Simpson College, and
the University of Tennessee, Martin. There
are several other similar products on the
market for creating online course Web
sites, some of which are free for evaluation
and limited educational use. Two of the
most popular are WebCT and Blackboard.
Based on initial response to the Course
Web Wizard, CIS may look into some of
these other products as well.

So, if you are interested in an easy to use,
and quick way to set up a course Web
page, try the Course Web Wizard! The
Course Web Wizard site is located at
http://www.hmc.edu/cww/. CIS is also
planning a workshop on how to use the
Course Web Wizard in early January. If you
would like to use it to set up a course Web
site please send email to cww@hmc.edu so
that an account can be created for you. z

by Craig Adkins, CIS
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Accessibility continued from page 1

The WAI Web Content Accessibility
Guidelines are a valuable resource for
every Web page author. They provide
concrete guidelines for creating Web pages
that are accessible to the blind and to
others with disabilities. If you’re a Web
page author you’ll want to take a look at
the complete guidelines which are
available on the Web at http://
www.w3.org/WAI/GL/. Here are some of
the highlights, though:

PROVIDE ALTERNATE TEXT
Use the “ALT” attribute to provide textual
descriptions of every image on your Web
page. Without alternate text, screen readers
will simply read the default description of
“IMAGE” for any images they encounter
on a page. Using alternate text is
particularly important for graphical
buttons, image map regions, graphical
representations of text and symbols, and
images used as list bullets. Alternate text
should also be used for audio files, audio
tracks of video, and video. Using alternate
text will also help non-disabled users who
turn off image loading when accessing the
Web over slow modem lines or who are
using a text-only Web browser such as
Lynx.

USE COLORS WISELY
Using color alone to convey information
can hinder users with color deficits or
monochrome displays. Choosing
background and text colors that are too
close to the same hue can make it difficult
to read or print Web pages.

USE HTML MARKUP TAGS PROPERLY
Misusing HTML markup tags for
presentation effects (e.g. using a table for
page layout) can confuse screen reader
software and make it extremely difficult
for a disabled user to understand the
organization and content of a Web page.
Other examples of using markup tags
improperly are using header tags for font

(continued on page 5)
In honor of the last pre-Y2K
issue of Occasional Downtime we have
several interesting articles for you. CIS
recently installed a new application on
our main Web server called the Course
Web Wizard. The Course Web Wizard
can be used by faculty to quickly and
easily set up course Web sites.

We also have a follow-up to our April
article on network security which details
enhancements we’ve made to our
current security policy.

Our main article, though, is on the
subject of Web page accessibility for the
disabled. One of the main attractions of
the World Wide Web is the fact that it
has made so much information available
to so many people all over the world.
Making sure that this information is
accessible to all segments of the
population is a major topic of concern.

We hope you enjoy this issue of
Occasional Downtime. Have a great
winter break!

—Elizabeth Hodas

Occasional Downtime is published bimonthly

by the Computing and Information Services
Department at Harvey Mudd College. It is also

available in PDF format on the HMC Web Server.

Comments and questions can be directed to
downtime@hmc.edu.

 ditor’s Notes
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On Guard! New
Network Security
Measures at HMC
In the April issue of Occasional Downtime
we discussed some of the issues involved
in network security. Network security
continues to be a topic of concern for us at
CIS, especially since we have had a higher
than usual incidence of system break-ins
on campus this semester. Most of the
break-ins involved Linux boxes; some
were student-owned machines in the dorms
while others were department-owned
machines. Linux has become an increasingly
popular platform on campus. Unfortunately,
the basic installation has a number of security
holes, which, if not properly patched, leave
the system vulnerable to break-ins by hackers
outside HMC.

The HMC Computing Committee has been
meeting this semester to discuss changes to
our security policy. The Committee has been
searching for a solution that would limit
outside access to computers on campus while
still allowing everyone on campus to perform
their work without restrictions. Based on the
recommendations of the Committee, CIS has
implemented some enhancements to our
network security policy. Starting with the
academic departments we have blocked off-
campus access to most departmental
computers. This blocking takes place at the
router level. The router blocks incoming
packets for protected computers that are
initiated by computers that do not have a
Claremont Colleges IP address. Users are
still able to access the Internet as they
normally do, but hackers have no way to
access the users’ computers from outside.
THE HMC COMPUTING COMMITTEE
Bill Alves, Humanities and Social Sciences
Andrew Cosand, HMC Class ’00

Elizabeth Hodas, CIS

Josh Hodas, Computer Science
Richard Parker, CIS

Ruye Wang, Engineering

Bob Wolf, Physics

In each department there are a small
number of computers, such as Web servers,
FTP servers, and mail servers, that require
access initiated from the outside. These
machines were given new IP addresses
from a range of IP addresses that are not
blocked. Faculty and staff who use an ISP
(Independent Service Provider) to access
their computer system from home have
also been given the option to request one
of these IP addresses. Users who dial in to
HMC’s modem pool are not affected. Only
those users who use an ISP to connect to
the HMC network and then connect to
their own system require a change to their
IP address.

Protecting the computers in the academic
departments was the first phase of our new
security policy. It took place in November.
This phase has gone very well and we are
ready to begin the next phase—protecting
student computers in the dorms. This phase
will begin in December. For more
information about our security policy
please contact Richard Parker at extension
18613. z
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Accessibility continued from page 3

effects instead of to designate actual
headings and using the <BLOCKQUOTE>
tag to create indentation. While such misuses
were difficult to avoid in early versions of
HTML, more recent versions have offered tags
intended for formatting control.

MAKE TABLES MORE ACCESSIBLE
Even tables that are used properly to
display tabular information can confuse
reader software. Reader software reads
from left to right and can jumble the
content of a table as it reads across
columns. Using the <TH> tag to identify
row and column headers and adding a table
summary using the “SUMMARY” attribute
can help make a table more accessible.

USE MOVING OBJECTS CAREFULLY
Moving objects on the screen such as
blinking, scrolling, or auto-updating
objects or text can be very confusing and
distracting to people with cognitive or
visual disabilities. In addition screen
readers can’t read moving text. Use these
techniques sparingly, if at all, or provide
alternatives that users can access instead.
Another option is to provide a mechanism
for users to pause or stop moving objects.

These are specific guidelines for making
pages more accessible to the blind and
disabled. But there are many other more
general measures you can take to make
sure that your pages are accessible to
everyone, including the disabled. For
example, it’s very important to test your
Web pages on multiple Web browsers and
multiple platforms. Pages developed in
Netscape Navigator on a Macintosh
computer can look quite different in
Internet Explorer on a PC, or even in
Netscape Navigator on a PC. Differences
in monitor capabilities, such as monitors
that only support 256 colors, monochrome
monitors, or small monitors can also make
a great deal of difference in how readable
and understandable a Web page is.
The use of new technologies can also be a
double-edged sword. While new
technologies such as style sheets and
applets can greatly enhance Web sites, they
can limit users who have older browsers
that don’t support these features or who
cannot take advantage of them due to
disabilities. Web page authors should take
into account the concept of “graceful
transformation.” In other words, Web pages
should be designed so that they work even if
the features provided by the new techno-
logies are not available. If this is not possible,
then authors can provide alternate pages.

The Center for Applied Special Technology
(CAST) provides a very useful source in
evaluating the accessibility of a Web site
called Bobby. It is available at http://
www.cast.org/bobby/. Bobby will take a
URL and return a report with any accessi-
bility or browser compatibility problems it
finds. CAST even provides an icon that can
be posted on a Web site when it receives a
Bobby Approved rating. The World Wide
Web Consortium also provides an HTML
validation service located at http://
validator.w3.edu. This service takes a
URL and returns a report on its compliance
with W3C HTML Recommendations. z

SOURCES
Word Wide Web Consortium

http://www3.w3.org/

HTML 4.0 Specification
http://www.w3.org/TR/REC-html40/

Web Accessibility Initiative

http://www.w3.org/WAI/

Web Accessibility Guidelines

http://www.w3.org/WAI/GL/

HTML Writers Guild
http://www.hwg.org/

AWARE Center http://aware.hwg.org/

National Federation of the Blind
http://www.nfb.org/

W3C HTML Validation Service

http://validator.w3.org/

Bobby http://www.cast.org/bobby/

Casey, Carol, “Accessibility and the

Educational Web Site,” Syllabus, Vol. 13, No.
2, September 1999, pp. 26-30.
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 ANSWERS
QUESTIONS and
Q: I’ve been using Eudora on my
Macintosh for a while now and
recently I’ve been getting a message
complaining about the amount of
memory it needs. What can I do
about this?

A: A short-term solution to this problem is
to quit Eudora and allocate more
memory to Eudora. After quitting
Eudora use the Finder to locate the
Eudora application file and single-click
on it to select it. Select ‘Get Info’ from
the Finder’s ‘File’ menu to display the
Eudora Info dialog box. In the Memory
section of the dialog box type the
amount of memory you want Eudora to
have in the “Preferred Size” box and
close the window.

However, if you are getting this
message it might also be an indication
that it’s time to clean up some of your
mailboxes. Eudora estimates the
amount of memory it needs based on
your open windows and the size of the
‘In’, ‘Out’ and ‘Trash’ mailboxes since
they’re in memory all the time. The
best way to reduce how much memory
Eudora needs is to clean up these
mailboxes regularly by deleting old
unwanted mail or by transferring
messages to other mailboxes for long-
term storage.

Creating new mailboxes is simple. Just
select the message or messages you
want to move to a new mailbox and
select ‘New...’ from the ‘Transfer’
menu. Type in the name of your new
mailbox and click OK. You can now
transfer other messages to this mailbox
at any time by selecting the message
and then selecting the mailbox from the
‘Transfer’ menu. You can even group
mailboxes together under folders. You
can learn more about folders in the
Eudora manual.

Another way to reduce the memory
Eudora needs is to compact your
mailboxes. When you delete messages
from a mailbox the storage space
which that message originally required
is not always automatically freed. You
can see how much space is wasted by
checking the mailbox size display in
the lower left corner of the mailbox
window. You should see three numbers
in this display. The first is the number
of messages in the mailbox; the second
is the total amount of space those
messages require; and the third is the
amount of disk space wasted with the
mailbox. In order to compact the
mailbox click (Command click on the
Macintosh) in the mailbox size display.

Q: I want Eudora to check to see if I
have new mail automatically. How do
I do that?

A: Select ‘Settings…’ from the ‘Special’
menu on the Macintosh or ‘Options’
from the ‘Tools’ menu on the PC. Click
on the ‘Checking Mail’ icon. You should
see an option for “Check for mail every
__ minutes.” Type in a number in the
empty box and then click OK. It’s best to
choose a time increment of at least 15
minutes. Checking more often than that
puts an unnecessary load on the POP
server. To disable this feature, just leave
the box empty.

Another option under “Checking Mail”
is the “Leave mail on server for __
days.” This feature should not be
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A

checked unless you are using Eudora at
home over PPP and also use Eudora in
your office. If you only use Eudora in
your office and you check this option
Eudora will leave a copy of all of your
mail on the POP server instead of
deleting it whenever you download
new mail. Eventually this will cause
problems for Eudora as it will time out
searching through all of your old mail
looking for new mail.

: I tried to read my email using Eudora
this morning and I got an error
message saying that my password is
incorrect. I never use my password
with Eudora anyway so what’s wrong?

: When Eudora retrieves your mail from
thuban, HMCADM or some other POP
server it must, for security reasons,
know your account password. While
we do not recommend using this
feature, Eudora has an option to save
your password after the first time you
retrieve mail so that it doesn’t have to
ask for it each time.

If for some reason you change your
password, then the password stored in
Eudora will be out of date. To solve
this problem you must tell Eudora what
your new password is. To do this select
‘Forget Password’ from the ‘Special’
menu. Then select ‘Check Mail’ from
the ‘File’ menu and type in your new
password when you are prompted for
it. Do not use the ‘Change Password’
menu command. This will change your
password on the server again, rather
than changing your password stored by
Eudora.

One reason your thuban or HMCADM
password might have changed is that
these servers have very strict security
procedures. They both require periodic
password changes. If you login to
thuban or HMCADM interactively
using Telnet or by dialing-in from
home (continued on page 8)
THE AUTOCORRECT FEATURE IN WORD
Word 97 and Word 98 have many
timesaving features for the user. In
particular, the AutoCorrect feature
anticipates some of the most common
typing and spelling mistakes users make
and corrects them for you. For instance,
AutoCorrect will correct words in which
you type two initial capital letters instead
of one, capitalize the first word of a
sentence if you don’t, capitalize the names
of days of the week, correct accidental use
of the Caps Lock key, and replace specific
text as you type. For example, if the user
types (c) Word will replace it with the
copyright symbol ©.

Another feature of AutoCorrect is
‘AutoFormat As You Type.’ For example
Word will automatically format bulleted
and numbered lists as you type, will
replace fractions with the fraction
character, will replace ordinals with
superscript characters, and will replace
Internet and network paths with
hyperlinks.

While these features can be very useful
when you need them, they can also be very
annoying when you don’t! In those cases it
is useful to know how to turn the
AutoCorrect features off. To do so, select
‘AutoCorrect’ from the ‘Tools’ menu. Find
the feature that you want to disable and
uncheck the check box next to it. For
example if you don’t want Word to turn
your URL’s into hyperlinks, then uncheck
the box labeled “Internet and network
paths with hyperlinks” in the ‘AutoFormat
As You Type’ section. z
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Q&A continued from page 7

with a modem, you will be prompted to
change your password if it has expired.

Q: Every time I try to send email in
Eudora I get a message that I am
sending to a bad email address. I know
the address is right. What is going on?

A: Eudora may be not be referring to the
message you are trying to send, but to
an older message that had a bad email
address and never actually got sent. To
check for this problem go to the
‘Mailbox’ menu and select the ‘Out’
mailbox. Look for a message that has a
“Q” in one of the columns next to it. If
there is such a message double-click on
it to open it and carefully examine the
email addresses in the To:, CC: and
Bcc: fields.

If any of these fields have an email
address that is badly formed Eudora
can’t send the message and will save
the message in your ‘Out’ mailbox
until you either fix the address or
delete the message. Every time you
send a new message Eudora tries to
send the old queued message too which
is why you keep getting the error
message. Some common email address
mistakes are Eudora aliases that don’t
resolve to actual email addresses or
mailing list addresses which are
missing the “@hmc.edu” ending.

Q: I want Eudora to save a copy of every
mail message that I send. How do I
do that?

A: Select ‘Settings…’ from the ‘Special’
menu on the Macintosh or ‘Options’
from the ‘Tools’ menu on the PC. Click
on the ‘Sending Mail’ icon. You should
see an option for “Keep copies of
outgoing mail.” If this option is
checked then Eudora will keep a copy
of each message you send and put it in
the ‘Out’ mailbox. If it is not checked
then outgoing messages are put in the
‘Trash’ mailbox after they are sent.

Q: I sent a message this morning and now
I want to send another copy of it to
someone else. I found a copy of the
message in my ‘Out’ mailbox but when
I double-click on it to open it, Eudora
won’t let me edit the To: field. What
am I doing wrong?

A: Eudora won’t let you edit messages
you’ve sent (or messages that you’ve
received for that matter). If you want to
send the message to another person you
need to use the ‘Send Again’ command.
Select the message you want to send by
opening it or single-clicking on it. Then
select the ‘Send Again’ command from
the ‘Message’ menu. Edit the To: field
with the email address you want to
send the message to and then click the
‘Send’ button. z
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